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Abstract

This report presents two methods for the covalent immobilization of capture antibodies on cellulose filter paper grade No. 1 (medium-flow filter
paper) discs and grade No. 113 (fast-flow filter paper) discs. These cellulose paper discs were grafted with amine functional groups through a
silane coupling technique before the antibodies were immobilized on them. Periodate oxidation and glutaraldehyde cross-linking methods were
used to graft capture antibodies on the cellulose paper discs. In order to ensure the maximum binding capacity of the capture antibodies to their
targets after immobilization, the effects of various concentrations of sodium periodate, glutaraldehyde, and capture antibodies on the surface of
the paper discs were investigated. The antibodies that were coated on the amine-functionalized cellulose paper discs through a glutaraldehyde
cross-linking agent showed enhanced binding activity to the target when compared to the periodate oxidation method. IgG (in mouse reference
serum) was used as a reference target in this study to test the application of covalently immobilized antibodies through glutaraldehyde. A new
paper-based, enzyme-linked immunosorbent assay (ELISA) was successfully developed and validated for the detection of IgG. This method
does not require equipment, and it can detect 100 ng/ml of IgG. The fast-flow filter paper was more sensitive than the medium-flow filter paper.
The incubation period of this assay was short and required small sample volumes. This naked-eye, colorimetric immunoassay can be extended
to detect other targets that are identified with conventional ELISA.

Video Link

The video component of this article can be found at https://www.jove.com/video/54111/

Introduction

The point-of-care testing (POCT) diagnostic study is important for the development of new strategies for therapeutics, personalized medicine,
and home care1. Cellulose papers are widely used as platforms in immunoassays, as they are cheap, accessible, and familiar to users2. In
addition, the porous structure of cellulose paper possesses the power to drive liquid flow without additional energy impact. Records of paper-
based bioanalysis can be found as early as the 20th century, when paper chromatography was first invented in 1952. The most prevalent
example is immunochromatographic tests3, such as pregnancy and diabetes test strips. These tests provide relatively fast assay times and
inexpensive analysis4. Due to their simplicity, these conventional paper strip tests have been widely used in POCT diagnostics5.

Detection methods including colorimetric6, electrochemical7, and electrochemiluminescence8 methods have been reported to measure targets in
biological samples. In addition to these quantitative methods, a reliable method for immobilizing antibodies on cellulose paper is also important
for the development of diagnostic devices. Non-specific adsorption is the main strategy for modifying antibodies on the surface of the paper-
based devices9, 10 to ensure maximum binding capacity to their targets after immobilization. However, a previous study showed that antibodies
that are adsorbed onto cellulose paper can desorb from the fibers11 by 40%. Thus, direct adsorption of antibodies onto cellulose may not provide
reproducible results12. Covalent immobilization of antibodies that are grafted on the paper surfaces is an alternative method of developing
effective paper-based bioassays13. Various methods have been reported for the modification of cellulose14, 15. Ideally, antibodies should maintain
their original functionality after immobilization12. Carbonyldiimidazole combined with 1-cyano-4-dimethylaminopyridinium tetrafluoroborate16; 1-
fluoro-2-nitro-4-azidobenzene through a UV-based activation strategy17, 18; a chemoenzymatic strategy based on xyloglucan modification19; a
1,4-phenylenediisothiocyanate linking agent20; heteropolysaccharide oxidation21 click chemistry22; and cationic porphyrins23 have been used to
covalently immobilize biomolecules on cellulose paper. Chitosan modified paper has been used to develop paper based immunodevices24-26

since it is abundant and biocompatible27. Chitosan is cationic and adheres strongly to anionic cellulose27. The capture antibodies are immobilized
on the paper through chitosan coating and glutaraldehyde cross-linking. Periodate oxidation is another method for grafting the capture antibodies
on the cellulose paper28. In this method, sodium periodate is spotted on the paper to convert 1,2-dihydroxyl (glycol) groups in cellulose directly
to aldehyde groups. The aldehyde groups are then used to form covalent bonds between polysaccharides and antibodies28. Although the
fabrication is simple, it is difficult to completely wash out sodium periodate. The unwashed sodium periodate can cause further oxidation of
the antibodies that are immobilized on the cellulose paper, affecting the activity and stability of the antibodies. N-(3-dimethylaminopropyl)-N-
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ethylcarbodiimide hydrochloride and N-hydroxysuccinimide cross linkers are also used to covalently immobilize antibodies on electrospun poly-L-
lactic acid and cellulose acetate nanofibers for the development of nanofiber-based assays29.

In this study, a silane coupling technique was used to graft amine functional groups on cellulose paper discs. This technique helps to retain the
original pore size, wicking, and filtration rate of the cellulose filter papers, allowing maximum vertical flow-through in immunoassays. The silane
coupling technique has been widely used in biosensors to functionalize substrate surfaces with secondary amine groups, followed by further
modification using biomolecules. The grafting of amine groups on the matrix surface comprises a condensation reaction between -OH groups of
the organofunctional silane agents and matrix substrate30. The cellulose paper discs were functionalized with amine groups by silane coupling
through 3-aminopropyltrimethoxysilane (APS)31. This was followed by covalently immobilizing capture antibodies using two different methods.
The first method involved binding of periodate oxidized capture antibodies to the amine functionalized cellulose paper discs. The second method
used glutaraldehyde as a cross-linking agent to attach the capture antibodies to the amine group-functionalized cellulose paper discs. The
presence of capture antibodies was confirmed by rabbit anti-human IgG-fluorescein isothiocyanate (FITC), using a fluorescence molecular
imager. The binding activity of rabbit anti-human IgG-FITC to goat anti-rabbit IgG was also evaluated by peroxidase substrate. The effects of
various concentrations of sodium periodate, glutaraldehyde, and capture antibodies were investigated. The application test of the immobilized
capture antibody was successfully performed through the detection of IgG serum.

Protocol

1. Grafting Amine Functional Groups on Cellulose Paper Discs

1. Prepare one piece of square paper with a dimension of 1 cm × 1 cm, and 100 paper discs made from grade No. 1 cellulose paper with a
diameter of 6.0 mm (medium-flow filter paper) using a hole punch.

2. To derive -NH2 groups on the paper discs, mix 1 ml APS and 10 ml acetone in a 50 ml glass bottle in the fume hood. Add paper discs to the
freshly prepared APS reagent mixture, and incubate for 5 hr with orbital stirring (200 rpm) at room temperature32.
 

Caution: Handle APS and acetone in the fume hood.
3. Decant excess solution from the 50 ml glass bottle into an organic waste container.
4. Add 10 ml of acetone to the glass bottle, mix well and decant completely to remove any unreacted APS and other impurities. Repeat this step

two times.
5. Spread the paper discs on the paper towel and place in a 110 °C oven for 3 hr. Allow the paper discs to cool. Store the discs in a 50 ml

centrifuge tube at room temperature.
6. Use Fourier transform infrared spectroscopy (FTIR) to check the grafting of amine groups on the cellulose square paper, as described below

(Figure 3A).
1. Turn on the computer and open the FTIR spectroscopy instrument.
2. Open the software for FTIR spectroscopy.
3. Go to 'Measurement → Initialize'. The rectangles for 'BS: KBr', 'Lamp: Infrared' and 'Laser' will turn green when the initialization is

finished.
4. Choose 'Data' below the rectangles, and select '%Transmittance', 'Happ-Genzel', '45', '4.0', and 'Min: 400, Max: 4000' for 'Measurement

Mode', 'Apodization', 'No. of Scans', 'Resolution', and 'Range (cm-1)'.
5. Click 'Measure'.
6. Select 'Data file' for the background data. Write down the comments.
7. Click 'BKG' to get the baseline for the background.
8. Fix the square paper on the film sample holder.
9. Select 'Data file' for the sample data. Write down the comments.
10. Click 'Sample' to obtain the spectra for the sample.
11. Close the FTIR spectroscopy application and turn off the computer.

7. Repeat the above steps (steps 1.1 to 1.6) to prepare amine-functionalized grade No. 113 cellulose square paper and discs (fast-flow filter
paper), and obtain the FTIR spectra for the grade No. 113 square paper (Figure 3B).
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2. Covalent Immobilization of Antibodies on Amine-functionalized Cellulose Paper Discs

 

Figure 1. Covalent immobilization of antibodies by two different methods. A. Antibodies immobilized on amine-functionalized cellulose
paper discs through periodate oxidation. The carbohydrate residues were oxidized by sodium periodate to produce aldehyde functional groups.
Then, the oxidized antibodies were loaded onto amine-functionalized cellulose paper discs. B. The antibodies were then immobilized on
amine-functionalized cellulose paper discs through glutaraldehyde. The amine functionalized cellulose paper discs were immersed in 0.05%
glutaraldehyde solution to introduce aldehyde groups to the paper discs. After washing, antibodies were loaded onto the aldehyde functionalized
paper discs. Please click here to view a larger version of this figure.

1. Immobilize antibodies on amine-functionalized cellulose paper discs through periodate oxidation (Figure 1A).
1. Mix 1 µl of 2.5 mM sodium periodate with 2 µl of 0.1 mg/ml rabbit anti-human IgG-FITC and 7 µl of 100 mM pH 5.5 acetate buffer in a

1.5 ml tube, and incubate the mixture in the dark for 30 min.
 

NOTE: Follow this volume ratio to prepare more oxidized antibodies if necessary. Change the volume ratio to optimize the
concentration of sodium periodate and rabbit anti-human IgG-FITC.

2. Dilute the above antibody solution with 30 µl of 50 mM phosphate buffer saline (PBS; pH 7.4) to a final volume of 40 µl.
3. Prepare three amine-functionalized medium-flow filter paper discs and three amine-functionalized fast-flow paper discs (as described in

Section 1).
1. Load 5 µl of the sodium periodate oxidized rabbit anti-human IgG-FITC onto each medium-flow filter paper disc and 8 µl onto

each fast-flow filter paper disc. Keep these paper discs in the dark for one hour at room temperature.

4. Wash each of the paper disc with 0.2 ml of washing buffer (50 mM Tris buffer with 0.15 M NaCl and 0.05% surfactant, pH 7.4). Repeat
the wash three times.

5. Photograph the fluorescence images through a fluorescence molecular imager to identify the presence of antibodies on each cellulose
paper disc32. Use blank paper discs (treated with the same concentration of antibodies in the absence of sodium periodate) as a control
(Figure S1 to Figure S3).
 

NOTE: For experimental optimization, change the concentration of one parameter that needs to be optimized and fix the concentrations
of all other parameters. A high fluorescence intensity increases the amount of capture antibodies that are immobilized on the cellulose
paper discs.

2. Immobilize antibodies on amine functionalized cellulose paper discs through glutaraldehyde (Figure 1B).
1. Add the three APS treated medium-flow filter paper discs and the three fast-flow filter paper discs (described in Section 1) to 2 ml of 50

mM PBS (pH 7.4) that contains 0.05% glutaraldehyde for 1 hr, with orbital stirring at room temperature.
 

Caution: Handle glutaraldehyde in the fume hood.
2. Place three discs each in two 1.5 ml centrifuge tubes. Add 1 ml of deionized (DI) water to each tube and shake the tubes for 10 sec.

Remove the water by aspirating with a pipette. Repeat two more times to remove any unreacted glutaraldehyde.
3. Load 5 µl of 25 µg/ml rabbit anti-human IgG-FITC (capture antibody) onto each aldehyde-functionalized medium-flow filter paper

disc, and add 8 µl onto each aldehyde-functionalized fast-flow filter paper disc. Incubate in the dark for approximately 20 min at room
temperature. Then, add 10 µl of 50 mM PBS (pH 7.4) to each paper disc without removing the antibodies and incubate for 40 min for
the amine aldehyde reaction.
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4. Wash the paper discs with 0.2 ml of washing buffer on top of a paper towel. Repeat the wash two times.
5. Photograph the fluorescence images through a fluorescence molecular imager to check for the presence of antibodies on each

cellulose paper disc33. Use blank paper discs as a control.
 

NOTE: In Figure 4, '0' stands for the blank paper disc that was treated with the same concentration of FITC-antibody in the absence
of glutaraldehyde; in Figure 5A, the blank paper discs were treated with glutaraldehyde, but no FITC-antibodies were loaded onto the
paper discs.

3. Dry the paper discs (from Sections 2.1 and 2.2) at 37 °C for 10 min.
4. Block the paper discs with 15 µl of blocking buffer (10% skimmed milk powder in 50 mM Tris buffer, pH 7.4, with 0.15 M NaCl) for 10 min at

room temperature.
5. Load 5 µl and 8 µl of peroxidase conjugated goat anti-rabbit IgG in PBS (1:10,000) onto medium-flow and fast-flow filter paper discs,

respectively. Incubate for 30 min in the dark at room temperature.
6. Wash the paper discs with 0.2 ml of washing buffer on top of a paper towel. Repeat the wash three times.

 

NOTE: It is not necessary to remove the washing buffer as the results are not affected by the buffer.
7. Load a 10 µl mixture of 3,3',5,5'-tetramethylbenzidine (TMB) and hydrogen peroxide solution onto each disc.
8. Take images of the paper discs with a digital camera or smart phone after 5 min of incubation.

 

NOTE: In Figure 5B, '0' stands for the paper discs that were treated with glutaraldehyde, followed by loading antibody-HRP (horse radish
peroxidase) conjugate in the absence of FITC-antibody.

3. Paper-based ELISA for IgG Detection

 

Figure 2. Schematic representation of the paper-based ELISA for IgG detection. Capture antibodies were covalently immobilized on the
aldehyde-functionalized cellulose paper discs through glutaraldehyde. The cellulose paper discs were blocked with blocking buffer. Target IgG
was then added to the discs, followed by the loading of HRP-conjugated signal antibodies. Finally, the TMB and hydrogen peroxide mixture
solution was loaded onto each paper disc for the color readout. Please click here to view a larger version of this figure.

1. Add 5 ml of 0.05% glutaraldehyde solution (prepared in 50 mM PBS buffer, pH 7.4) to a 20 ml glass bottle. Immerse 15 amine-functionalized
medium-flow filter paper discs in this solution and keep for 1 hr with shaking at room temperature.

1. Concurrently, repeat Step 3.1 to prepare another 15 aldehyde functionalized fast-flow filter paper discs.
 

Caution: Handle glutaraldehyde in the fume hood.

2. To remove unreacted glutaraldehyde from the paper discs, place the 15 medium-flow filter paper discs in a 15 ml centrifuge tube, and the 15
fast-flow filter paper discs in another 15 ml centrifuge tube. Add 5 ml of DI water to each tube and shake the tubes for 10 sec. Remove the
water by aspirating with a pipette. Repeat two times to remove any unreacted glutaraldehyde.

3. Dry the paper discs in a 37 °C oven.
4. Add 5 µl and 8 µl of 0.025 mg/ml mouse IgG-Fc fragment antibodies to each of the medium-flow and fast-flow filter paper discs, respectively,

and incubate for 20 min.
5. Add 10 µl of 50 mM PBS (pH 7.4) to each paper disc without removing the antibodies and incubate for 40 min for the amine aldehyde

reaction.
6. Wash the paper discs with 0.2 ml of washing buffer on top of a paper towel. Repeat the wash three times.
7. Dry the paper discs in an oven at 37 °C.
8. Block the paper discs with 15 µl of blocking buffer for 10 min at room temperature.
9. Wash each paper disc with 0.2 ml of washing buffer on top of a paper towel. Repeat the wash three times.
10. Run IgG standards.

1. Load 10 µl of various IgG concentrations (e.g., 0, 10, 125, 250, and 500 ng/ml in PBS) onto each disc in triplicate. Incubate for 1 hr at
room temperature.

11. Wash the paper discs with 0.2 ml of washing buffer on top of a paper towel. Repeat the wash three times.
12. Load 10 µl of HRP conjugated mouse IgG-Fc fragment antibodies (1:10,000, 10 mM PBS, pH 7.4), and incubate for 1 hr at room temperature.
13. Wash the paper discs with 0.2 ml of washing buffer on top of a paper towel. Repeat the wash three times.

 

NOTE: It is not necessary to remove the washing buffer as the results are not affected by the presence of buffer.
14. Load a 10 µl mixture of TMB and hydrogen peroxide onto each disc.
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15. Take images of all paper discs with a digital camera or smart phone after 5 min of incubation.
 

NOTE: In Figure 6A, '0' stands for paper discs treated with capture antibody immobilization, and the antibody-HRP/TMB solution without IgG
serum.

16. Analyze the intensity of each paper disc in the image by Image J.
1. Convert the images taken in step 3.15 to '.tif' format.
2. Open 'Image J' software.
3. Go to 'File → Open', choose the image to analyze.
4. Choose the shape button 'Oval'.
5. Go to 'Image → Type → 32 bit'.
6. Go to 'Edit → Invert'.
7. Go to 'Analyze → Measure'.
8. Copy and analyze the data in a spreadsheet.

Representative Results

 

Figure 3. Fourier transform infrared (FTIR) spectra of untreated and APS-treated medium-flow filter square paper (A) and fast-flow filter
square paper (B). A. The spectra for untreated medium-flow filter square paper was similar to that of APS treated medium-flow filter square
paper. The increase in intensities at bands of 902-1,170 cm-1 and 1,210-1,500 cm-1 for the APS-treated square paper belonged to Si-O-cellulose
and C-H deformations of SiOC-H groups, respectively. The increment of the bands at 1,650 cm-1 and 2,885 cm-1 belongs to the bending of -NH2
and CH2 vibrations from the saline propyl moiety, respectively. B. The characteristic peaks in the 972 to 1,180 cm-1 range were attributed to the
Si-O-Si and S-O-cellulose bonds. The peak at 1,003 cm-1 was caused by the overlap of the Si-O-Si bond and the C-O stretching of cellulose. All
of the results show that APS was successfully grafted onto the cellulose square papers. Please click here to view a larger version of this figure.

https://www.jove.com
https://www.jove.com
https://www.jove.com
http://ecsource.jove.com/files/ftp_upload/54111/54111fig3large.jpg


Journal of Visualized Experiments www.jove.com

Copyright © 2016  Journal of Visualized Experiments October 2016 |  116  | e54111 | Page 6 of 11

The presence of amine functional groups on the cellulose square papers were determined by FTIR. Figure 3 shows the FTIR spectra of
untreated, modified, medium-flow and fast-flow filter square papers. There were three steps involved in the chemical modification of aminoalkyl
groups, using APS on the cellulose surfaces. Step one involved the hydrolysis of APS to provide the silanol derivative of APS. Step two involved
the adsorption of the hydrolyzed APS derivative onto the cellulose fibers through hydrogen bonding of OH groups from the hydrolyzed APS
derivative and the cellulose fibers. Step three involved the condensation of the adsorbed APS derivative, which led to the grafting of the APS
derivative onto the cellulose fiber's surface through Si-O-C bonding and the formation of Si-O-Si siloxane bridges34. As shown in Figure 3A, the
increment of the band at 1,650 cm-1 was attributed to the bending of NH2 groups and an increment of the band at 2,885 cm-1 corresponding to
the CH2 vibrations of the silane propyl moiety. For the original medium-flow filter square paper, the bands at 902-1,170 cm-1 and 1,210-1,500
cm-1 corresponded to the vibrations of the C-O-C bonds of glycosidic bridges and CH stretching vibrations. After treating the square paper with
APS, the increase in intensity at these two band widths indicates that they belong to Si-O-cellulose and C-H deformations of SiOC-H groups,
respectively. Similar to medium-flow filter square paper, the spectra for modified fast-flow filter square paper also increased in intensity at 1,650
cm-1 for -NH2, due to the chemical modification with APS (Figure 3B). The strong characteristic peaks in the 972 to 1,180 cm-1 range were
attributed to the Si-O-Si and S-O-cellulose bonds; the highest peak was at 1,003 cm-1 due to the overlap of the Si-O-Si bond and the C-O
stretching of cellulose34. The characteristic bonds in the wavelength range between 1,188 and 1,510 cm-1 for APS treated square paper are
caused by the vibrations of the C-O-C bonds of glycosidic bridges and CH stretching vibrations. The CH2 stretching vibration bonds were shown
at 2,800-2,980 cm-1 and the highest peak was at 2,932 cm-1 for the APS treated square paper. In conclusion, APS can be covalently grafted to
No. 1 and No. 113 filter square papers.

 

Figure 4. Fluorescence responses to different concentrations of glutaraldehyde in the immobilization of IgG-FITC on the paper discs
(Method B). Settings for fluorescence molecular imager: Excitation, 488 nm, emission, 530 nm, resolution, 100 micrometer. A: Fluorescence
response to 0, 0.001%, 0.005%, 0.01% and 0.050% glutaraldehyde. B: Fluorescence response to 0, 0.050%, 0.100%, 0.250% and 0.500%
glutaraldehyde. The concentration of IgG-FITC on each disc was 0.01 mg/ml. An increase in the concentration of glutaraldehyde to a maximum
of 0.05% resulted in an increased loading amount of IgG-FITC. Concentrations of glutaraldehyde above 0.05% decreased the loading amount of
IgG-FITC. Please click here to view a larger version of this figure.

 

Figure 5. Fluorescence response (A) and colorimetric result (B) of different concentrations of IgG-FITC on the IgG-FITC-immobilized
medium-flow and fast-flow filter paper discs (Method B). Settings for fluorescence molecular imager: Excitation, 488 nm, emission, 530 nm,
resolution, 100 micrometer. #1 represents grade No. 1, medium-flow filter paper disc, and #113 represents grade No. 113 fast-flow filter paper
disc. APS-modified paper discs were treated with 0.05% glutaraldehyde first. Then, different concentrations of IgG-FITC were loaded onto the
glutaraldehyde modified paper discs. Increasing the loading concentration of IgG-FITC increased the amount of the immobilized IgG-FITC on the
paper discs. However, increased concentrations of immobilized IgG-FITC did not improve the binding capacity to the antigen. Please click here
to view a larger version of this figure.
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The basic workflow for the covalent immobilization of antibodies on amine-functionalized cellulose paper discs is shown in Figure 1. The
rabbit anti-human IgG-FITC was covalently immobilized on the cellulose paper discs. The fluorescence from the paper discs indicated the
immobilization of antibodies to the paper discs, and the intensity of fluorescence was directly proportional to the concentration of immobilized
antibodies. Peroxidase conjugated goat anti-rabbit IgG was then applied to determine the binding capability of the immobilized antibodies.
Secondary amine groups and aldehyde groups can react with each other to form a Schiff base, which has been used in bioconjugation35. They
were also used here for covalent immobilization of capture antibodies. In method A (Figure 1A), -NH2 was introduced to the cellulose paper
discs and -CHO was derived from the rabbit anti-human IgG-FITC by oxidizing the Fc region of the antibodies with sodium periodate. In the
same way, the effects of various concentrations of sodium periodate and IgG-FITC antibodies were also analyzed. As shown in Figure S1 and
Figure S2, sodium periodate from concentrations of 0 to 1 mM and the rabbit anti-human IgG-FITC from 0.016 to 0.16 mg/ml had little effect on
the oxidation of 0.08 mg/ml rabbit anti-human IgG-FITC. The amount of antibodies that were covalently bound to the paper discs increased with
an increasing concentration of capture antibodies from 0 to 0.075 mg/ml (Figure S3A).

A faint color change was observed when the binding capability was determined by the peroxidase assay. This might be due to the use of excess
sodium periodate, which reacts with the capture antibodies and causes a loss of binding activity. It is likely that the sodium periodate cannot
be completely washed away from the paper discs. This was confirmed by the simple principle that sodium periodate solution provides a yellow
color when mixed with purpald solution. Therefore, periodate oxidized antibodies were loaded onto the paper discs and incubated for 1 hour.
The paper discs were washed three times with PBS (containing 0.05% tween-20), and then purpald solution was added to these discs. The
paper discs showed a purple color immediately, indicating the presence of aldehyde groups from periodate-oxidized antibodies. This purple color
changed to yellow within 10 minutes, which confirmed the presence of sodium periodate on the paper discs.

Alternatively, a glutaraldehyde cross-linking method (method B, Figure 1B) was used to link the amine groups from the APS-treated paper
discs and antibodies. The concentrations of glutaraldehyde (Figure 4) and rabbit anti-human IgG-FITC (Figure 5A) that were loaded onto the
cellulose paper discs were optimized. As shown in Figure 4, the fluorescence intensity reached a maximum of 0.05% of glutaraldehyde, which
means that the loading of rabbit anti-human IgG-FITC became saturated on the cellulose paper disc at this concentration; an increase in the
concentration of glutaraldehyde to 2.5% did not show an increase in the amount of rabbit anti-human IgG-FITC on the cellulose paper discs
(Figure S4). The fluorescence intensity also increased with increasing concentrations of rabbit anti-human IgG-FITC that were loaded onto the
paper discs (Figure 5A). A blue color developed immediately upon the addition of the TMB substrate and hydrogen peroxide mixture solution
to the paper discs, which contained the peroxidase conjugated detection antibodies (Figure 5B). In addition, blocking buffer that contained 10%
skimmed milk powder was shown to retain the blocking efficiency after 15 washes (Figure S5). Method B was selected to test the application of
the immobilized antibodies, as it demonstrated enhanced binding activity to its target. Hence, a 0.025 mg/ml concentration of capture antibodies
was used for IgG detection.
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Figure 6. Calibration curves for the determination of IgG by paper-based ELISA. #1 represents grade No. 1, medium-flow filter paper disc,
and #113 represents grade No. 113 fast-flow filter paper disc. The upper panel A presents the color readout for medium-flow (#1) and fast-flow
(#113) cellulose paper discs with different concentration of IgG. The bottom panel B presents the ELISA result for different concentration of IgG.
Triplicates were used to determine the standard deviation (SD). Please click here to view a larger version of this figure.

Goat anti-mouse IgG-Fc fragment capture antibody, IgG serum, and goat anti-mouse IgG-Fc fragment antibody conjugated HRP were used
for the sandwich assay. As shown in Figure 6 and Figure S6, the concentration of IgG serum from 0 to 500 ng/ml had a linear relationship
with colorimetric intensity when each step was incubated for 1 hour. In Figure S6, the color variation with different concentrations of IgG was
obvious for 1 hour of incubation. Yet, the results of the 10 min incubation did not show an obvious change in the color intensity with different
concentrations of IgG. Thus, the sensitivity of this paper-based ELISA was suitable for developing practical point-of-care testing.

Figure S1. Fluorescence responses to different concentrations of sodium periodate (Method A). Varying concentrations of sodium
periodate were mixed with rabbit anti-human IgG-FITC at a concentration of 0.016 mg/ml and used for the study of antibody oxidation activity.
By increasing the concentration of sodium periodate, the loading amount of IgG-FITC increased and reached a maximum at 0.25 mM. It was
observed that concentrations of sodium periodate that were higher than this did not increase the amount of immobilized IgG-FITC. Triplicates
were used to determine the standard deviation (SD). Please click here to download this file.

Figure S2. Fluorescence responses to different concentrations of rabbit anti-human IgG-FITC (Method A). The concentration of sodium
periodate was 0.25 mM in the solution for the antibody oxidation activity study, and the final concentration of rabbit anti-human IgG-FITC on each
disc was 0.016 mg/ml. When the concentration of sodium periodate was fixed, the concentration of IgG-FITC had little effect on the oxidation of
IgG-FITC. Triplicates were used to determine the standard deviation (SD). Please click here to download this file.
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Figure S3. Fluorescence response and colorimetric result from loading different concentrations of oxidized rabbit anti-human IgG-FITC
onto the paper discs (Method A). For sodium periodate oxidation, 0.08 mg/ml of IgG-FITC and 0.25 mM sodium periodate were used. The
dilution of peroxidase-conjugated anti-rabbit IgG was 1:50,000. Increasing the loading concentration of IgG-FITC on the cellulose paper discs
increased the amount of immobilized IgG-FITC, but did not have an effect on target binding. Please click here to download this file.

Figure S4. Fluorescence response to high concentrations of glutaraldehyde in the immobilization of IgG-FITC on the cellulose paper
discs (Method B). The concentration of IgG-FITC on each disc was 0.01 mg/ml. Concentrations of glutaraldehyde that were higher than 0.25%
did not increase the quantity of immobilized IgG-FITC on the cellulose paper discs. Please click here to download this file.

Figure S5. Effect of number of washing times. A: washing three times. B: washing 15 times. Capture antibodies immobilized on the cellulose
square paper still had good binding capacity to their targets, even though the square paper was vortexed 15 times. Please click here to download
this file.

Figure S6. Paper-based ELISA result for IgG. For the concentrations of IgG from 0 to 500 ng/ml, the results from one hour of incubation are
better than the results from 10 minutes of incubation. For high concentrations of IgG, 10 minutes is enough time for incubation. Triplicates were
used to determine the standard deviation (SD). Please click here to download this file.

Figure S7. Scanning electron microscopy (SEM) images of medium-flow filter paper at different magnifications. A: 85X and B: 20,000X.
Field emission scanning electron microscopy (FE-SEM) operating at 5 kV was employed to determine the particle morphology. The cellulose
fibers are randomly cross-linked. Please click here to download this file.

Figure S8. SEM images of fast-flow filter paper at different magnifications. A: 100X and B: 20,000X. Field emission scanning electron
microscopy (FE-SEM) operating at 5 kV was employed to determine the particle morphology. The cellulose fibers are randomly cross-linked.
Please click here to download this file.

Discussion

Direct coating of affinity purified goat anti-Mouse IgG-Fc capture antibody on unmodified cellulose paper discs was performed to detect IgG
concentrations. The results indicated that, further fixation of the capture antibodies is required for reproducibility. The silane technique was
successfully used to introduce amine functional groups to the cellulose paper discs34. The concentration of APS affects the immobilization
of antibodies. Therefore, the amount of APS in acetone was also optimized. 1 ml of APS in 10 ml of acetone was an optimal concentration
for grafting the amine group for the immobilization of antibodies through a glutaraldehyde cross-linking agent. Antibodies were grafted on
the cellulose paper discs by periodate oxidation and glutaraldehyde cross-linking methods. Our results revealed that the binding capacity of
immobilized antibodies through the glutaraldehyde cross-linking method was better than the periodate oxidation method for medium-flow and
fast flow-filter paper discs. Furthermore, capture antibodies, which were immobilized on cellulose paper discs through a glutaraldehyde cross-
linking method, retained their function and were stably immobilized even though the paper was subjected to the mechanical stress of 15 washes
by vortexing. Ten percent of the skimmed milk powder blocking buffer was found to retain its blocking efficiency after 15 washes (Figure S5).

The covalently immobilized antibodies were used to perform a sandwich ELISA with the detection of IgG. IgG at a concentration of 100 ng/
ml was detected with the naked eye using this paper disc based assay. The concentration of IgG serum from 0 to 500 ng/ml showed a linear
relationship with colorimetric intensity, when each step was incubated for one hour. The immunoassay testing for this paper disc based ELISA
required less sample reagent and appeared to be more efficient than conventional immunoassays36. The results showed that the sensitivity of
fast-flow filter paper disc based immunoassay was higher than that of the medium-flow filter paper based immunoassay. The morphologies of
medium-flow and fast-flow filter paper discs that were obtained by field emission scanning electron microscopy are shown in Figure S7 and
Figure S8, respectively. As illustrated in these figures, the fibers are randomly cross-linked for both kinds of filter paper discs25. The reason for
this high sensitivity might be the thickness of the paper disc. For fast-flow filter paper discs the thickness was 420 µm compared to 180 µm for
medium-flow filter paper. Thus, more capture antibodies were likely to be immobilized on fast-flow filter paper discs, which would further increase
the sensitivity of the assay. At the same time, the pore size for the fast-flow filter paper discs (30 µm) was larger than that of the medium-flow
filter paper discs (11 µm). After paper surface blocking, the pore size of the former was still large enough to drive liquid flow without an extra
power system. However, the rate of flow for the buffer in the latter was slower. Therefore, fast-flow filter paper was better than medium-flow filter
paper in the application of immunoassays.

The reproducibility of the antibodies on the immobilized filter paper discs was evaluated by further incubation of the paper discs with peroxidase-
conjugated goat anti-rabbit IgG and detection of the colorimetric result after loading the TMB substrate and hydrogen peroxide mixture solution.
The standard deviation was less than 10% for this paper-based device. The stability of rabbit anti-human IgG-FITC on the -NH2 modified
cellulose paper discs was tested for up to two months. The paper discs that were stored at 4 °C maintained their binding activity to peroxidase-
conjugated goat anti-rabbit IgG with a slight decrease in their binding activity. However, when the antibody immobilized paper discs were stored
at room temperature or 60 °C, they lost their binding activity due to the dryness and high temperature. The captured antibodies could have
destabilized and denatured under these conditions.

There are some critical steps in the immobilization of capture antibodies on the cellulose paper discs using glutaraldehyde as a cross-linking
agent. Step 1.2 to graft amine groups on the paper discs is a critical step in the successful covalent immobilization of capture antibodies. If
this step fails, the entire immobilization process will fail. FTIR was used to determine whether amine groups were successfully immobilized
on the paper discs (step 1.6). Second, the grafting of aldehyde groups on the cellulose paper discs is another critical step (Step 2.2.1 and
Step 3.1). The antibodies were covalently immobilized on the cellulose paper discs through the formation of a Schiff base. Finally, the step to
immobilize capture antibodies on the filter paper discs is important (Step 2.2.3, Step 3.4, and Step 3.5). The amine groups from the capture
antibodies reacted with the aldehyde groups from the cellulose paper discs to fix the antibodies on the paper discs. If this step was unsuccessful,
capture antibodies would not immobilize on the paper discs and all of the ELISA application tests would be negative. We can use a fluorescence
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molecular imager to determine the presence of capture antibodies. Peroxidase-conjugated goat anti-rabbit IgG and peroxidase-based
colorimetric reactions can be used to confirm the binding capacity of the immobilized antibodies.

This protocol may encounter some problems, such as a high background to the signal, no signal or a weak signal, and an uneven color readout.
The possible causes of these problems and troubleshooting methods for overcoming these problems are discussed below. High background
signals usually occur due to a short blocking time. This can be solved by increasing the blocking incubation time, washing the paper discs
thoroughly, and avoiding the addition of excess detection antibody conjugate enzyme to remove high background signals. The possible causes
include an absence of target antigen, over blocking, insufficient incubation time, and a non-functional detection antibody enzyme conjugate. To
overcome these issues, the target antigens must be added and incubated for a suitable time period using a new antibody conjugate and storing
it as suggested by the manufacturer. It is advisable to include a positive control for detection. Uneven color readouts are due to the stacking
of paper discs during the grafting process. To avoid this problem, the paper discs must be separated during the APS grafting process, and the
antigen and detection antibody conjugate enzyme must be spread uniformly on the paper disc at each step.

Although the paper-based assay is a simple and cost effective method, there are limitations. The orientation of antibodies on the substrate
surface is critical to the performance of the immunoassay, as the glutaraldehyde cross-linking agent reacts with the amine groups from the Fab
region and the Fc region of the capture antibodies. Thus, the immobilized antibodies do not occur in a highly oriented manner. Since there are
more amine groups from the Fab region than from the Fc region of the IgG antibodies, the binding activity of the immobilized antibodies is still
high enough for their application.

Different surface functionalization methods for cellulose paper were summarized in a recent report37. Reagents such as divinyl sulfone;
1,4-phenylenediisothiocyanate; 4-azido-benzenediazonium; epichlorohydrin; 4-azido-a-fluoro-2-nitrocyclohexane; and 4-mercapto-
benzenediazonium, could be used to covalently immobilize biomolecules on cellulose paper. Adsorption and entrapment were also utilized to
coat the cellulose paper with biomolecules. Compared to the other methods, the combination of the silane technique and the glutaraldehyde
cross-linking agent for covalent immobilization of antibodies on cellulose paper is a simple method. In addition, this combination may have little
effect on the thermal and mechanical performance of the cellulose paper, allowing the maximum vertical flow-through in immunoassays. This
strategy could be extended to immobilize other biomolecules on the cellulose paper.

The methodology demonstrated here could potentially be extended to the detection of any analyte, as long as direct antibodies against it are
available. This method can also be used to develop multiplex detection. For example, on a square paper, different areas can be distinguished
for various targets. The capture antibodies for the targets can be immobilized through a glutaraldehyde cross-linking agent on their specific area.
This can be followed by the ELISA procedure to detect various targets. Thus, the proposed method makes the paper-based ELISA a versatile
tool for the detection of other targets using the naked eye.
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